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RESUMO

O presente trabalho tem como objetivo apresentar os estudos sobre sistemas
supervisorios visando a constru¢do de um simulador para treinamento de operadores
de subestacao de sistemas elétricos, em situagdes criticas. O simulador se fundamenta
em estudo realizado sobre 0 erro humano na operagdo dos sistemas, na empresa
CHESF. Nesta empresa ¢ ambiente de supervisdo é desenvolvido no ambiente SAGE,
no entanto como este sistema nao foi disponibilizado para o projeto da interface com o
simulador, esta foi construida a partir de um outro supervisorio Para tanto foi realizado
um estudo sobre sistemas supervisérios afim de se escolher o mais adequado ao
projeto. Durante este projeto foram também estudadas as caracteristicas do sistema
real implantado na empresa de modo a compreender os seus aspectos que poderiam
estar influenciando na ocorréncia de falhas de operacdo na opinido dos operadores de
uma subestacdo da empresa. O objetivo desta andlise foi propor mudangas na
interface do supervisorio atual, além de apoiar a construgade do simulador no que diz
respeito a recriar em ambiente de testes adequado ao treinamento dos operadores em
situacdes criticas de operacao, durante as quais terdo de encontrar a melhor solu¢éo

para um problema no menor tempo possivel.

Palavras Chave: Sistema Supervisério, Parametrizagdo, Testes de Usabilidade,
Interface Homem-Magquina




ABSTRACT

This work shows some studies about supervisory systems being aimed at the
construction of a simulator for training of operators of electrical systems, in critical
situations. The simulator if bases on study carried through on the human error in the
operation of the systems, in company CHESF. In this company the supervision
environment is developed in environment SAGE, however as this system was not it was
used for the project of the interface with the simulator, this was constructed from one
another supervisory For in such a way was carried through a study on supervisory
systems similar of if choosing most adequate to the project. During this project also the
characteristics of the real system implanted in the company had been studied in order to
understand its aspects that could be influencing in the occurrence of imperfections of
operation in the opinion of the operators of the company. The objective of this analysis
was to consider changes in the interface of the current supervisory, besides supporting
the construction of the simulator in that it says respect to create again in adequate
environment of tests to the training of the operators in situations you criticize of
operation, during which will have to find the best solution for a problem in the lesser
possible time.

Key words: Supervisory, Parametrization, Tests of Usability, Man-Machine Interface
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Introducgédo

Na medida em que o desenvolvimento tecnolégico cresce, os equipamentos vao se
tornando cada vez mais confiaveis, por conseguinte, a causa das falhas do sistema vai
passando a ser do operador. De acordo com levantamentos feitos em algumas
empresas mais de 80% das falhas na operagéo s&o oriundas do fator humano. O que
indica a necessidade do desenvolvimento de interfaces de operacdo que oferegam
recursos para o aprendizado e para apoio a deciséo, o que levaria a operagdo mais
segura destes sistemas.

Neste sentido, um ambiente que emule o sistema real de operag¢ao pode ser de
grande valia no treinamento de operadores, o que sera conseguido a partir da
parametrizacao de um software do tipo SCADA, o qual representara um ambiente real
de operagéo, ligado a um motor de simulagdo. O ambiente de simulagdo que sera
abordado € uma subestacio elétrica.

O processo ao qual o software supervisdrio estard conectado serd representado
pelo modelo de uma subestagdo elétrica, mais precisamente a subestacac de CGD.
Este modelo, construido em Redes de Petri Coloridas, se comunicara
bidirecionalmente com o software supervisorio.

Neste projeto serdo abordados além da parametrizagdo do software supervisério, a
impiementag&o de uma estratégia de comunicagao entre o supervisério e 0 modelo que
representa a operagao da planta.

Obijetivo geral

O objetivo principal deste projeto & a construgdc de um simulador para o
treinamento de operadores de sistemas elétricos, a partir da construgao de sua
interface com um sistema supervisério, de modo a representar com o maior realismo

possivel a o sistema atuaimente instalado na empresa CHESF.

Objetivos especificos

Parametrizacao do supervisério instalado na na subestagdo de CGD, da empresa
CHESF, estabelecendo a comunicagao TCP/IP entre um software supervisério e o
modelo da planta, construido em Redes de Petri Hierarguicas (HCPN) de modo a

viabilizar uma plataforma de estudos de IHM.
1




Organizag¢ao do trabalho

Este trabalho, além desta introdugdo, € composto de quatro capitulos mais
referéncias bibliograficas.
No primeiro capitulo, Sistemas Supervisérios, s&0 apresentados os trés tipos de

sistemas supervisorios envolvidos no projeto: SAGE, que é o sistema presente na
CHESF de Campina Grande e os dois que foram estudados para a sua
parametrizacdo, o ELIPSE e o INDUSOFT. E apresentada uma comparagao entre os
softwares justificando a opg&o pela utilizagao do INDUSOFT no projeto.

No Segundo capitulo, Modelando uma Subestagao, é apresentado todo o processo

para a criagdo do modelo, que consta desde 0 estudo de caso, visitas a subestagao,
entrevista com os operadores do sistema, até a impiementagéo do projeto no InduSoft
Web Studio.

No terceiro capitulo, Comunicacac, & apresentada a forma de comunicagdo via
Web, entre a IHM com outras instancias clientes ou com outro software, como o Excel
ou Access.

No quarto capitulo, Conclusdes, sdo apresentadas as analises dos resultados.
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CAPITULO 1 - Sistemas Supervisoérios

Nos ultimos anos, o constante crescimento dos setores elétrico e industrial vem
sendo amparado e viabilizado por um grande desenvolvimento tecnolégico, em
conjunto com a modernizagdo dos sistemas de comunicagdes, formando assim um
ambiente ideal para a implementacdo de sistemas de automacao cada vez mais
sofisticados.

Neste escopo estao os sistemas de comunicagbes, o desenvolvimento de
protocolos, equipamentos de medicdo e controle e a utilizagdo de suportes
computacionais. Neste sentido, as Interfaces Homem-Maguina — IHM exercem um
papel fundamental. Uma interface mal projetada pode causar fadiga durante a
operacaoc ou até mesmo induzir a erros, e assim, comprometer o trabalho de operagéo
do sistema em questao.

Software do tipo SCADA (Supervisory Control and Data Aquisition) € um software
para supervisdo, controle e aquisi¢do de dados, usado em solu¢gbes de automacgéo e
controle de processos, sao conhecidos como supervisorios. Sao programas muito
flexiveis, através dos quais pode-se configurar todo © processo controlado,
cadastrando-se todos os pontos controlados no campo em um banco de dados.

Pode-se também criar telas que representem o processo, ou seja, uma Interface
Homem-Maquina, por onde se pode iniciar um processo de comando simplesmente
com o uso do mouse, 0 que substitui os controles tradicionais, tais como botoeiras e os
painéis de controle que ocupam muito espago. Claro que atualmente varios processos
nos quais foram implantados um sistema de automagao com um software supervisério,
nac foram abandonados ou retirados os controles manuais, a justificativa dos
administradores dos sistemas para este fato € na utilizacdo do sistema manual em
caso de falha do sistema supervisério, muito embora os sistemas supervisarios venham
com um confiavel sistema de seguranga usando estratégias, tais como: duplicidade de
rede, duplicidades de servidores (implementacdo hot-standby), duplicidade de
estacdes.

Na maioria dos casos os softwares supervisérios vém acompanhados de um
compilador usado na execuc¢do de rotinas que podem ser criadas pelos préprios
usuarios para a aplica¢ao, muitas vezes as linguagens utilizadas sdo proprias dos
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fabricantes do software, muito embora, em alguns casos seja possivel implementacao
em linguagens de programagaoc mais comuns como C, C++ e outras.

E importante salientar que dentre as caracteristicas dos softwares SCADA esta o
fato de serem configuraveis pelo usuario e a grande diversidade de dispositivos aos
quais podem ser conectados e trocar informagdes, isso € possivel devido ao fato de
serem implementados diversos drivers de comunicacdo e protocolos, sendo os
mesmos incorporados ao software, muitas vezes sdo disponiveis também ferramentas
para a implementagdo de novos protocolos para o caso de insercdo de novos
dispositivos com protocolos de comunicagao diferentes dos ja implementados.

Atualmente os sistemas sao implementados em plataformas Unix, Windows NT,
Windows2000 e OS/2, sendo configurados em intranets com protocolos TCP/IP, o que
torna possivel visualizagéo e controle do processo em qualquer lugar do mundo onde
se tenha disponivel uma conexao pra WEB, claro que para isso o sistema deve ter um
médulo para tal tipo de conexao.

Para a implementagdo da IHM foi realizada uma pesquisa com 0s principais
softwares de automacgao do mercado, aonde foram analisados dez softwares SCADA
dedicados a automagéo de processos bem como a area elétrica.

A analise foi feita segundo os seguintes parametros:

e Mobdulo de desenvolvimento: Permite que um usuario desenvolva e
teste suas aplica¢des.

« Mdédulo Runtime StandAlone: Programa que executa em uma maquina
e controla um processo.

¢ Modulo RunTime Servidor de BDTR: Programa que executa em uma
maquina e controla um processo. Difere do StandAlone por permitir outros
médulos clientes.

» Modulo Master: Licenga para executar em uma (nica maquina ¢ médulo
de desenvolvimento e o “runtime”. Desta forma, 0s dois modos possuem
uma unica licenga.

o Moddulos de Comunicagao: Consiste nos diversos protocolos e canais
de comunica¢ado que um software possui disponivel.

e Mobdulo Cliente e Servidor da Base de Dados Corporativa: Consiste
em um médulo que é caracterizado pela preseng¢a de um servidor de base
de dados onde sao guardados os dados histéricos.
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e Mobdulos Clientes de Interface Homem-Maquina (IHM): Consiste na
disponibilidade de configuracdo de IHM para maquinas que serdo
utilizadas como clientes.

o Modulo Servidor de Web: Esse médulo corresponde a um RunTime
Cliente do Servidor de BDTR mas servidor de WEB. Assim, usuarios via
browswer podem acessar as informagdes disponibilizadas peio médulo
servidor de Web.

» Banco de Dados relacional para dados de tempo real: Consiste na
inter-relagao entre tabelas que constituem a base de dados na qual séao
armazenados os valores e variaveis utilizadas pelo Software em tempo
real.

« Banco de Dados Relacional Para Dados Histéricos: Consistem na
inter-relacdo entre tabelas que constituem o banco de dados onde séo
armazenados os dados histéricos.

e Possui demo.

+ Vantagens apresentadas como singulares.

Com isto foram analisados os seguintes softwares:
+ Software SAGE, produzido pela CEPEL.
o Software Elipse, produzido pela Elipse.

e Software Indusoft, produzido pela Indusoft.

1.1 - Software SAGE

O Sistema implementado na Chesf de Campina Grande foi desenvolvido no
ambiente SAGE, assim se fez necessario estudar o software para conhecer todas as
suas singularidades e desta forma, realizar a meihor escolha sobre ¢ supervisério que
sera utilizado para a parametnzagao.

Os procedimentos para a configuragdo do Sistema Aberto de Gerenciamento de
Energia — SAGE, que permite supervisionar e controlar um processo de produgao,
transmissao e distribuigao de energia elétrica, inclui as seguintes etapas:

15




s Banco de Dados: carregamento dos dados em um ambiente off-line,
gerando a Base de Dados Fonte e a partir desta a Base de Dados Referéncia
(Imagem da Base de Dados Tempo Real em disco), também off-line,;

o Telas: edicido de telas e associagéo dos seus pontos dindmicos com a Base
de Dados Referéncia;

+ Interface Grafica: configuracdo do controle de acesso, dos fontes, das
cores, das telas e dos relatorios.

O SAGE pode ser configurado para um modelo de dados EMS (Energy
Management System) ou simplesmente para um modelo de dados SCADA
(Supervisory Control and Data Acquisition System).

Para se configurar o Banco de Dados do SAGE sao necessarios os seguintes
passos:

» Modelagem dos dados para preenchimento da Base Fonte.
o Carregamento da Base Fonte.

» Carregamento da Base de Referéncia.

A Base Fonte do SAGE utiliza um modelo de dados relacional. Uma base de dados
relacional € modelada através de entidades, atributos e relacionamentos entre
entidades.

 Entidade: € um ente abstrato que caracteriza um ponto fundamental para a
organizagao das informag8es em uma Base de Dados Relacional, ou seja, ¢
algo sobre o qual se deseja armazenar informagoes;

e Atributo: € o nome dado a uma caracteristica da entidade, isto €, os atributos
de uma entidade definem as informacgdes que se deseja armazenar sobre
ela;

o Relacionamento: € a maneira pela qual, duas entidades estao associadas.

Para se mapear entidades, atributos e relacionamentos, utilizam-se tabelas, aonde
uma unidade corresponde a uma tabela e cada atributo desta unidade corresponde a
um campo dessa tabela. O relacionamento € a forma como 0s campos entre as tabelas
estio relacionados.

A configuracdo do SAGE estd organizada segundo os subsistemas que o

compdéem. Para o modelo SCADA ¢é configurado o Subsistema de Suporte
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Computacional (SSC) e o Subsistema de Comunicacao e Pré-processamento de
Dados (SCD).

O SSC é responsavel pelo gerenciamento do processo da base de dados
distribuida, seletivamente replicada, residente em memdria e utilizada em tempo real
(méduio CMCD); é também responsavel pela distrivuicdo e monitoragao dos processos
nos diversos nés da rede (modulo GCD) e ainda oferece um servigo de alarmes e
eventos (modulo ALR).

O SCD implementa a comunicagao de dados com Centros de Controle, Unidades
Terminais Remotas (UTR), Controladores Légicos Programaveis (CLP) e outros
equipamentos e sistem,as diretamente conectados ao sistema de gerenciamento de
energia.

A Interface Grafica utiliza tecnologia Full Graphics, através do sistema X-Window e
biblioteca de objetos graficos OSF/Motif, apresentando controle de acesso baseado
nos conseitos de Acgbes e Privilégios, adaptavel a politica da empresa. Suporta
multiplas janelas com diagramas unifilares, tabulares, graficos de tendéncias, lista de
alarmes e eventos, etc. Recursos graficos de scrolling, panning, zooming, decluttering,
camadas e filtragem. Apresenta ainda, Editor Interativo de Telas (com associagao de
objetos graficos a enderegos na base de dados), SAGE Shell (para ativagdo de
programas diretos a partir da interface grafica), além de Flexibilidade de configuragao.

As telas do SAGE apresentam-se divididas nos seguintes visores:

¢ Visor de acesso: Envolve as atividades de controle de entrada e saida de
usuarios da interface do SAGE: ativacdo de programas, verificacdo dos
privilégios do usuario e dos estudos dos programas.

s Visor de alarmes. Mostra textualmente os alarmes. Pode-se reconhecer um
determinado alarme, elimina-lo e inserir uma anotagao.

+ Visor de logs: Apresenta o historico dos alarmes e eventos. Pode-se definir
as datas de inicio e fim para ser visualizado o arquivo e também o tipo de
informacao que sera exibida (alarme, evento).

» Visor de telas: E o sindtico da planta. Todo elemento tem uma janela de
confirmacdo para cada elemento em que se atua.

« Visor de histérico: E como o visor de Log, soh que de forma grafica.

e Visor de calculos: Definicao e monitoragdo de pontos calculados
dinamicamente na planta.
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Visor de base: Visualizagdo e alteracdo de dados do banco de dados do
SAGE.

Visor de processos. Controle € monitoragao de processos.

Visor de tendéncias: Mostra graficos de tendéncias para as variaveis do
pProcesso.

TsrMonitor: Monitoragdo e gerenciamento de canais de comunicagéo.

1.2 — Software ELIPSE

O Elipse SCADA & configuravel pelo usuario, permitindo a monitoragac de variaveis

em tempo real, através de graficos e objetos que estdo relacionados com as variaveis

fisicas de campo. E possivel fazer acionamentos e enviar ou receber informacdes para

equipamentos de aquisi¢do de dados. Apresenta uma liguagem de programacgao

denominada Elipse Basic, que permite automatizar diversas tarefas.

O Elipse encontra-se disponivel em quatro versdes, que se diferenciam na sua

funcionalidade.

Versdo View: E indicada para aplica¢des simples. As informagbes recebidas
pelo View estdo disponiveis também para outras aplicagbes que possam
trabathar com DDE (Dynamic Data Exchange). Apresenta fun¢bes de
monitoramento e controle, comunicagdo com PLCs e outros equipamentos
via drivers DLL, inclusive em blocos. Possui objetos de tela para a produgao
de interfaces e permite a importacac de imagens de editores graficos. Pode
ser utilizado como servidor para aplicagdes remotas.

MMI (Man Machine Interface): E indicada para aplicacdes de médio porte,
onde & necessario 0 armazenamento de dados, tratamento de informacgbes e
criacdo de relatérios complexos. Possui alem das caracteristicas presentes
na versao View, histéricos, receitas, relatérios, CEP (Controle Estastistico de
processos), novos objetos de tela e log de alarmes em disco.

Pro (Professional): E indicada para aplicagbes de qualquer porte, que
envolvam comunicacdo em rede, seja local ou remota ou ainda que
necessitem a troca de informagoes com bancos de dados. Possui além das
caracteristicas presentes na versdoc MMI, suporte ODBC (Open Database
Connectivity), suporte DAO (Data Access Objects).
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+ Power: Versdo destinada a supervisao de subestacdes e sistemas elétricos.
Permite conexao IEDs (Intelligent Electronic Device) e RTU (Remote
Terminal Units) através de qualquer protocolo de comunicacgéo.

O Elipse SCADA possui trés mddulos de operagdo, Configurador, Runtime e
Master. Os modulos Configurador e Master s&o destinados para a criagdo e
desenvolvimento de aplicativos, e o mddulo Runtime permite apenas a execucgio
destes. O médulo ativo é definido a partir de um dispositivo de protegao (hardkey) que
é acoplado ao computador, na auséncia deste dispositivo o software pode ser
executado em modo de demonstracao (Demo), no qual possui todos os recursos
existentes no modulo Configurador, com excegéo de que trabalha com um maximo de
20 tags (variaveis de processos) e permite a comunicagao com equipamentos de
aquisigao de dados por até 10 minutos.

O Elipse possui dois Plug-ins (ferramentas adicionais adquiridas separadamente) os
quais tornam possivel a monitoracéo de sistemas atraves de recursos de captura,
registro e transmissao digital de imagens em tempo real (Plug-in Elipse Watcher) e a
supervisao processos através da Internet (Plug-in Elipse Web).

1.3 — Software INDUSOFT

As aplicagdes IWS rodam em microcomputadores conectados em tempo real com
maquinas ou processadores através de controladores programaveis, equipamentos
remotos de /O e outros equipamentos para aquisi¢do de dados.

As aplicagbes desenvolvidas pelo Indusoft Web Studio consistem de telas de
operacado animadas, drivers de comunicagao (para PLCs e protocolos de E/S (I/O) tais
como Profibus, DF1, etc.), banco de dados de tags e méodulos adicionais, tais como
monitores de alarme (Alarm), légica (Math), graficos de tendéncia (Trend), receitas
(Recipes), agbes baseadas em eventos (Scheduler), e sistema de seguranca (Security
System). Estas aplica¢des interfaceiam com sistemas de E/S industriais e outras
aplicagbes em Windows no ambiente de runtime utilizando protocolos ODBC, DDE,
NetDDE, OPC, ou TCP/IP. Pode-se operar a aplicagido através de um navegador
comum de internet. A interface da aplicagao do IWS com sistemas /O industriais e
outras aplicagdes em modo runtime utilizam os seguintes protocolos:
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¢ ODBC (Open Database Conectivity)

» DDE (Dynamic Data Exchange)

¢ NetDDE (Network Dynamic Data Exchange)

+ OPC (Open Connectivity)

o TCP/IP (Transmission Control Protocol / Internet Protocol)

O produto consiste de dois componentes, o software de desenvolvimento e o
software runtime, que pode rodar em qualquer estacdo de interface com o sistema
operacional Windows NT/2000/XP/2003 Server ou Windows CE. Apés o
desenvolvimento de uma aplicagao, pode-se roda-la em sua estagdo de trabalho de
desenvolvimento ou fazer um download da aplicagao para uma estacao de trabalho em
runtime (utilizando uma conexdo TCP / IP ou em série) e assim roda-la com a utilizagéao
de softwares Indusoft Web Studio ou CEView. A estagéo runtime processa os dados
dos equipamentos conectados a ele (PLCs, E/S, etc) de acordo com parametros
definidos na aplicagao e reagem, exibem e armazenam os dados.

O IWS apresenta os seguintes recursos:

« [nterface Web que permite visualizar telas em um navegador Web (thin client)
através da Internet/Intranet e trocar dados com o servidor através de um
protocolo TCPAP.

« Configuracao e gerenciamento online de aplicagbes remotas.

» Biblioteca com mais de 100 simbolos e objetos dinamicos.

e Suporte a objetos Active-X.

« Uma API| de arquitetura aberta que permite troca de valores de tags do IWS
com produtos de softwares externos com suporte a arquitetura Microsoft. Net.

e Mais de 150 drivers de comunicacao com dispositivos diversos.

e Expressdes logicas e linguagem com mais de 200 fungdes.

e Integracdo com pacotes baseados em PC tais como ASAP, ISaGRAF,
SteepleChase, e Think&Do.

O software apresenta a versdoc Demo do produto em seu site para Download de
forma totaimente gratuita. Esta versdo permite ao usuario utilizar o software por 40
horas, incluindo também o Indusoft's CEView para CE v3.0 e CE.Net. A empresa IWS
do Brasil, representante dos produtos Indusoft no brasil, disponibilizou uma licenga

FULL para a realizacao do projeto. Esta licenga permite a utilizagéo de 512 mil tags, 24
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drivers, 32 Web Clients, modulos de engenharia e runtime. Foi feita entdo a escolha por
este software para a parametrizagdo do supervisério na substacao de CGD.
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Capitulo 2 - Modelando uma subestacgio

Em muitas situagbes, o sistema de automagao auxilia o operador em situacio de
operagao normal, no entanto é pouco eficiente em situagdes criticas, nestas situagoes,
alem da complexidade inerente & busca de solugbes, as tarefas sdo mais complexas e
os procedimentos ditados pelas normas s3o mais estritos do ponto de vista do erro
humano.

Em particular, na interagdo com sistemas de supervisao industrial, o volume de
informacgdes apresentado ac operador da planta é tipicamente elevado. Nos sistemas
supervisorios, a representagao do sindtico de uma planta industrial permite que o
usuario (operador) obtenha informagdes oriundas de diferentes tipos de equipamento e
sistemas, na forma de diagramas, controles para ajuste de set-points, listas de alarmes,
entre outras de complexidade semelhante. Algumas destas informac¢des demandam
uma resposta do usuario em um prazo estrito, além de impor restri¢des na navegagao
entre opgdes do sistema.

A concepgao de Interfaces por muito tempo foi considerada como uma atividade de
menor prioridade que as questdes relacionadas as funcionalidades (Scherer, 2004). A
partir dos anos 70, com a introdu¢éo e popularidade dos terminais de visualizagdo em
ambientes de trabalho, cada vez mais pesquisadores sdo motivados a estudarem a
concepgao de interfaces. Essa atengéo se traduziu em 1983 na criagédo do comité de
ergonomia da 1SO, ISO/TEC 159 ao qual foi destinada a tarefa de elaboracdo de um
padrao relativo a ergonomia.

A interface de um sistema € o ponto no qual o usudrio interage com ¢ sistema.
Desta forma dois produtos gque implementam as mesmas funcionalidades podem ser
diferenciados de acordo com a facilidade de uso, com a clareza das informagdes que
auxiliam o usuario durante a execucgado das tarefas e com a eficacia de suas operagoes.

O projeto consiste na implementagao de um sistema de supervisao e controle na
configuragdo StandAlone. O processo a ser controlado consiste na subestacdo (SE)
Campina Grande |l (CGD) do sistema CHESF, aqui a subestagdo serd simulada
através de um modelo hierarquico em Redes de Petri Colorida (HCPN). O protocolo de
comunicagao a ser utifizado pela estacdo de trabalho é o TCP-IP.

22




IHM de Supervisao Planta Industrial

(SCADA) (Modelo HCPN da SE)
| Rede
ethernet
TCPP
Fig 2.1. 1 —Sistema de supervisiio e controle

2.1 - Estudo de caso

O cenario desejado para o projeto era de o operador se conectar ao sistema, abrir o
sinético, verificar os alarmes, retornar ao sinético, atuar em um disjuntor, ir para o
grafico de tendéncias, voltar para o sinético, desfazer a operagéo no disjuntor e atuar
em outro, ir para a tela de alarmes, voltar para o sinético, desfazer a atuagao anterior,
atuar na terceira chave, observar as janelas de alarme e tendéncias, e finalizar com um
logout, ou retornando a tela de sinético.

Para este cenario portanto, fez-se necessario a construgao de cinco telas:

e Tela de Login: Possui a parte de login (no modelo & apenas uma transigao),
que € nome e senha, botdo de confirmacgéo e botao de limpar. O login pode
ser correto ou errado. Tem um botado para encerrar a aplicagdo. Os outros
botdes sao irrelevantes para o cenario.

e Tela Principal: Permite ao usuario se deconectar do sistema, e através do
menu pode-se chamar os outros 3 visores necessarios para o estudo de caso
(sindtico, grafico de tendéncias e alarmes/log).

e Sinético: Possui o sinético da planta.

e Alarmes/log: Mostra textualmente os alarmes.

e Visor de tendéncias: Mostra graficos de tendéncias para as variaveis do
processo.

Terminado o estudo de caso fez-se necessario uma visita a subestagdo Campina
Grande Dois (CGD), localizada na cidade de Campina Grande — PB, afim de observar a
forma de operagcao do software e seus recursos. Na ocasido, aproveitou-se para
conversar com os operadores sobre o sistema, analizando suas singularidades e
possiveis falhas. Detectou-se que algumas chaves ainda sao operadas manualmente,
apesar de serem monitoradas pelo supervisério. Na ocorréncia de alguma falha é
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gravado em um arquivo de histérico o horario da ocorréncia, o operador que estava
atualmente responsavel, e o procedimento que foi adotado para sua solugdo. O fato de
todas as falhas ficarem registradas em arquivo, cria nos operadores uma preocupacao
extra para que nenhuma falha ocorra durante o seu turno de trabalho.

Uma singularidade observada foi o recurso de zoom presente na tela de sinético, o
qual permite ao operador ter um detalhamento da tela.

2.2 - Criando o modelo

Um modelo é uma representacéo das principais caracteristicas de um objeto ou
sistema e pode consistir em uma descricdo matematica ou uma representacao fisica. A
utilizacdo de métodos formais na modelagem de sistemas se baseia no uso de
nota¢cdes com semantica bem definida, favorecendo o estabelecimento de métricas de
desempenho e possibilitando a discussao de propriedades do sistema modelado.

Neste trabalho, a utilizagao de modelos & motivada pela necessidade de investigar
propriedades relacionadas & ergonomia da interfface com © usuario sem
necessariamente lidar com ela de uma maneira direta. Fregqlientemente, no setor
industrial, lidar com o sistema real é invidvel ou mesmo impraticavel. A partir da
utilizacdo de modelos € possivel constatar a existéncia de propriedades desejaveis
bem como propriedades indesejaveis do sistema modelado, isto possibilita o estudo da
viabilidade de implementacgao solugdes para elimina-las.

Para a criagdo do modelo procurou-se seguir fielmente as telas presentes no
sistema SAGE, nao s6 a sua aparéncia mas tambem a sua forma de navegacgao para
que o operador sinta-se completamente familiarizado com a arquitetura. Assim, embora
para a simulagio do cenario fosse suficiente a criagao de apenas cinco telas, foram
criadas telas adicionais com o unico objetivo de manter fidelidade a navegagéo,
evitando que o operador “pule” algumas telas durante a manipulagdo do modelo. As
telas apresentam desabilitados os botbes que estao fora do escopo do projeto, e ao
serem pressionados apresentam a mensagem: “Opgao indisponivel”.

Estando definidas todas as telas necessarias a parametrizagao, iniciou-se o estudo
do supervisério Indusoft. Foram estudados dois documentos disponibilizados pelo
fabricante:

24




Getting Started Guide: Guia pratico, que informa sobre todas as funcionalidades
do software, modo de criagdo e customizagao de um projeto.

Apostila de treinamento: Apostila utilizada para treinamento de pessoal, gue
contém informacdes passo-a-passo da criagdo de um projeto do zero, insergao
de todas as suas ferramentas até a comunicacio via Web.

Terminado o treinamento com o supervisério iniciou-se a construgao do modelo, foi

criado entdo um novo projeto denominado “SimuladorChesf’, no qual comegaram a ser

produzidas as telas. O IWS disponibiliza a importacdo de Bitmaps, o que tornou

possivel a construgcdo de objetos graficos por softwares externos e depois

simplesmente importa-los, ¢ que permitiu tornar a aparéncia do modelo a mais proxima

possivel com a do real. O processo de criagao foi dividido em trés estagios:

Criacao das telas e biblioteca de simbolos: Nesta etapa preocupou-se com a
parte grafica, desenvolvendo a biblioteca de simbolos elétricos a ser utilizada no
projeto, criando botdes, e montando toda a interface. Para inserir um comando a
algum objeto da tela utilizou-se a propriedade “Command”, a qual permite
modificar o valor das tags (tipo de variavel, que pode ser booleana, inteira, real,
string, ou classe) através de uma logica baseada em planithas. Através da
propriedade “Position” é feito o gerenciamento da exibigcado dos objetos de
acordo com os valores das tags.

Criagao de planilhas de tarefas (Alarmes, Matematicas e Trend): Nas planilhas
de alarmes e de trend sdo inseridos as tags que deseja-se monitorar e suas
propriedades. As planilhas matematicas (math) séo utilizadas para a realizagao
das l6gicas inerentes ao projeto.

Criacao da comunicagao (TCP/IP): Desenvolveu-se um sistema de comunicagéo
via Web que permite operar o modelo em qualguer uma estacado Web Thin
Client.

2.2.1 — Criacao das telas

A primeira tela a ser produzida foi a tela "Login” que permite ao usuario informar seu

nome e senha para entrar no modelo. O IWS possui um modo de seguranga que

permite ao desenvolvedor criar grupos de usuarios e atribuir a cada um destes grupos

niveis de seguranga. Para o projeto foram criados trés grupos:
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e Engenharia: Permite ao usuario acesso total ao sistema. Destinado para o

desenvolvedor do produto.

* Operagao: Permite ao usuario acesso a toda parte de operagdo do sistema,

mas restringe acesso ao modo de engenharia, ndo permitindo assim

customizagdes no produto.

e Guest: Permite apenas a visualizagdo do sistema. Usuarios deste grupo nao

necessitam de senha.

ﬁ»

_l T by

ﬁru.nAmn: Engenharia

+ _|Users
Memm Security Level - Development
0 [ 255
Engineenng Access
[¥] Project Settings

— | [¥] Divers, Data Sources
) | = Nework Configuation
[¥] Create. modily tags

[ Create. modily screens
Create, modify task sheets

Securty Level - Runtime
o e (=

Auntime Access

[ Start App

[¥] Ciose App

[#] Database Spy (wite)

[¥] Task switch enabled

[7] Createliser enabled

3::
fll
: X

Group Name:  Engenharia

ok [ comcel ]

Figura 2.2. 1 — Configurando o modo de seguranca dos grupos

Para a construgdo da tela foram utilizadas as ferramentas graficas do IWS
(Rectangle, Line, Button, Fill color, etc.). No botdo Login, através da propriedade
Command, foi inserida a fungao interna Logon(), que permite especificar o usuario e a
senha, identificando desta forma a que grupo o mesmo pertence, definindo assim suas
permissdes. O botdo de Logout foi habilitado com a funcao Logoff() que desconecta o

usuario do sistema.
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IWS
Indusoft Web Studio

Base ssl_cgd
Modele: ems
Versao: 2006

Identificagio —
Usuane

Senha

Figura 2.2. 2 — Tela Login

O sistema de abas foi construido através de retangulos habilitados com a fungao
Open Screen, que permitiu realizar a navegacgao entre as telas.

Object Properties

1

42 [ Replace. | Hint: || command

' OnDown | OnWhie | OnUp | On Right Down 413 b

. | s El;am1

| Oo &=
- | Config... |

Ll

Figura 2.2. 3 — Funciio Open Screen utilizada para navegacio

A segunda tela produzida foi a “Principal’, que permite acesso as demais telas de
interesse. Esta tela permite ao usuario ter acesso as telas de Logout, Sinético, a tela
Campina Grande Il (CGD) e a tela CGD - CGU - BVT, que proporciona uma visdo geral
das subestagbes Campina Grande | (CGU), Campina Grande Il (CGD) e Bela Vista
(BVT). Os demais botbes presentes na tela encontram-se desabilitados, pois ndo
fazem parte do escopo do projeto, ao serem selecionados abrem a tela Aviso.scr.
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Figura 2.2. 4 — Tela Principal

Desculpe, opcao indisponivel no momento.

Figura 2.2. § — Tela Aviso.scr

Para a construgdo da tela de sinético fez-se necessario algumas modificagbes com
relacdo a tela original apresentada no SAGE. O IWS nao apresenta a funcionalidade de
zoom, entdo para a obtengdo deste tipo de efeito foram construidas mais cinco telas,
uma para o detalhamento de cada barramento. Estas telas sdo acessadas com um
simples clicar do mouse sobre a area que se deseja visualizar o detalhamento. A
construcdo das chaves foi feita através da superposi¢cao de dois bitmaps habilitados
com as ferramentas position e command.
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Figura 2.2. 6 — Tela Sinético e seu detalhamento

Para as telas de alarmes e Visor de tendéncias foi utilizada uma funcionalidade do
IWS denominada Background Tasks, a qual & responsavel pela execugao de logicas
(scripts) contidos nas planilhas matematicas (math) e pelo gerenciamento dos médulos
configurados, como nas planilhas de Alarmes, Receitas, Tendéncias e Relatérios.
Através desta ferramenta foram introduzidas as tags de interesse e suas respectivas
propriedades (Valor Maximo, minimo, efc.).

2.2.2 - Criacdo das planilhas de tarefas
Através das planilhas de tarefas sdo configuradas todas as l6gicas necessarias a
aplicacéo. Para o projeto foram utilizadas as planilhas Alarm, Trend e Math, afim de

atenderem respectivamente a criagdao de grupos de alarmes, grupos de tendéncias e
para a insercao de matematicas.
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Description: Group Name: Descrption:
Trend Valor Bruto e Quaddade H Alarmes tipo H
History Fomat Disable: Remote Ack: Colns
oy
ry Emad Setings.. | 7
(] Save On Trigger [#] Save On Tag Change Total Alarms: Display/Save Start
s —— ——
[¥]Sunmary ] To Printer FG| ~ |8~ BG
ot Ak [F5aveToDisk Ak
Tag Name Dead Band Clien [ BawisAd N 76 - (M- 86
1 Variavel{1]. Operacac_Qualidade Dead Band Time [sec. ] ot M Nom
2 Variavel[1].Operacao_FilPy Active: FG/mm - [mm~ BG
3 Variavel[2) Operacao_Qualidade Nom: | ] :
4 Vartavel[Z] Operacao_FilPv
5 Variavel[3) Operacao_Qualidade Type Umit Message Priortty = Selection
[ Variavel[3) Operacao_FilPy 4 -
1 Variavell4] Operacao_Qualidade 5 =
Description:
Pagna objetos
Execution
Tag Name Expression
1 Varini_1 Inicios[Pagev]
2 Varini_2 Inicios[Pagev+1]
3 Varini_3 Inicios[PageV+2]
4 Varni_a Inicios[Pagev+3]
5 Varini_5 Inicios[Pagev+4]
] Varinl_6 Inicios[PageVv+5]
7 Varini_7 Inicios|PageV+B]
] Varini_s Inicios[PageV+7]
[} Varlni_9 Inicios[Pagey+8]

Figura 2.2. 7 — Planilhas de tarefas: 1 - Trend, 2 - Alarm e 3 -Math

As planilhas estao localizadas na aba Tasks no Indusoft e foram inseridas clicando-
se com o botdo direito do mouse e selecionando a opc¢ao “Insert”. A planilha
matematica (Math) apresenta duas colunas, a primeira € denominada Tag Name,
aonde sao colocadas as tags que irdo receber o valor do calculo realizado na segunda
coluna, Expression. As expressfes matematicas s@o criadas a partir das funcbes da
Linguagem Indusoft Web Studio, que diferentemente de outras linguagem baseadas
em textos estruturados, nao se faz atribuicao de valores na coluna Expression.

Na planilha de alarmes foram inseridas as tags a serem monitoradas, o tipo de
alarme (Hi, Lo, HiHi ou LolLo) e os limites estabelecidos. Foram inseridas também
mensagem a serem informadas no momento que o alarme é disparado.

Na planilha Trend inseriu-se as tags de interesse e foi selecionado o Check Box
“Save On Tag Change”, para que o sistema salve os valores das tags toda vez que
elas mudarem de valor.
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Capitulo 3 - Comunicagao

E importante salientar que dentre as principais caracteristicas dos softwares
SCADA esta o fato de serem configuraveis pelo usuario e a grande diversidade de
dispositivos aos quais podem ser conectados e com o0s quais podem trocar
informagdes (Alves, 2004). Isso & possivel devido ao fato de incorporarem diversos
protocolos de comunicagdc. Sao¢ disponiveis também ferramentas para a
implementacdo de novos protocolos, possibilitando a insergdo de novos dispositivos
com protocolos de comunicacao diferentes dos ja implementados.

Atualmente os sistemas sdo implementados em plataformas Unix, Windows NT,
Windows2000 e OS/2, sendo configurados em intranets com protocolos TCP/IP, o que
torna possivel a visualizacao e controle do processo de qualquer local conectado a
WEB. Para isso o sistema deve ter um moédulo agregado que possibilite tal tipo de
conexao.

Antes dos sistemas OPC se tornarem realidade, a obtengadc de informagao de
CLP’s era bem mais complexa. Cada SCADA deveria possuir drivers especificos para
cada CLP, assim sendo, um SCADA como o Intouch, por exemplo, deveria ter um
driver para a Allen-Bradley, outro para Siemens, etfc., e além das diferentes marcas de
controladores, muitas vezes era preciso mais de um driver para cada fabricante, pois
esses diversificam a comunicagcdo criando diferentes familias de CLP’s. Essa
comunicagdo era baseada em DDE - “Dynamic Data Exchange”, “Troca de Dados
Dinamica”.

Para a parametrizacdo do supervisério da subestacac de CGD existia a
necessidade de se estabelecer uma comunicag¢ado entre o software supervisério e um
modelo HCPN em TCP/IP, afim de viabilizar uma plataforma de estudos para testes
relacionados a construgdo de IHM ergondmicas e avaliar o grau de conformidade da
plataforma montada com o sistema real. Foi criada entdo uma interface Web que
permite visualizar as telas em um navegador Web (thin client) através da
Internet/Intranet e trocar dados com o servidor através de um protocolo TCP/IP.

Primeiramente as telas foram salvas em formato HTML, através do menu File >
Save as HTML.

N




2 CAMYINST~11.. .\about.scr
3 CAMYINST~11,.. JMENU.SCR

InduSoft Web Studio

Figura 3. 1 — Salvando telas em formato HTML

Apoés este comando ter sido executados os arquivos Web foram armazenados na
subpasta \web no diretério da aplicagdo. Em seguida configurou-se a estagao servidor,
para isto através do menu Project > Settings selecionou-se a guia Web, na qual
especificou-se 0 endereco |P da estagao do servidor no campo Data Server IP Adress.
A estacdo Web Thin Client troca dados on-line (valores de tag) com a estacao que foi
especificada neste campo.

Identification || Options | Runtime Desktop | Commurication| Web | Preferences|

Data Server IP Send Period
L [ I R
[[Jpisable Remote Cliert Commands ] Auto Screen Scaling
[FlEnsble ToolTips [CJEnsble File Compression [ Psecuity.. ]
A== : - [ virtual Keyboard:
o Default: Ijte;p;di S :{ |
FileName: I l e

Scale: | 100% v |

ot 3 (Ccoen

Figura 3. 2 — Aba Web: Configurando o servidor
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A Microsoft fornece Web servers (servidores Web) para qualquer sistema
operacional da Microsoft (IIS). Para efeito de testes foi copiado o arquivo
NTWebServer.exe localizado no subdiretério \BIN do Indusoft e colado no diretério
\Web da aplicagdo e em seguida foi executado. Para atualizar os ajustes Web
selecionou-se o menu Tools > Verify Application.

Selecionou-se icone Run Application para executar a aplicagao localmente na
estacdo do servidor e disponibilizar deste modo para ser acessada via Web em
qualquer estagdo Web Thin Client, bastando-se abrir um navegador de internet e digitar
o endereco URL para abrir a TelaVisor.html (http://IP_do_Server/TelaVisor.html). Pode-

se alterar o status de qualquer chave localmente (estacdo do servidor) utilizando o

médulo run-time Viewer, ou remotamente (Web Thin Client), utilizando o navegador.
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Capitulo 4 — Conclusdes e Sugestoes

Apesar da automacdo nos processos industriais, inclusive no setor elétrico, a
intervencdo humana ainda ¢ indispensavel e se da mediante a interagdo com a planta
através de sua interface. Neste sentido a utilizagdo de regras de concepcao de
interfaces com principios ergondmicos leva o projetista ao desenvolvimento de
interfaces menos susceptiveis a falhas de projeto. Neste contexto, a utilizagdo de
modelos vem demonstrando ser uma forma vantajosa de representagao das interfaces
industriais.

Como trabalho futuro pode ser inserido o modelo em Redes de Petri Coloridas que
se comunicara bidirecionalmente com o software supervisorio, e desta forma poderiam
ser realizados os testes de usabilidade do sistema. Poderiam ser incluidos graficos de
tendéncias, os quais teriam como parametros o tempo levado para a realizagao de
tarefas versus o nivel de experiéncia do usuario. O tempo para a solugdo de problemas
€ cobrado com bastante veeméncia no ambiente real, 0 que entra em confronto com a
responsabilidade das decisdes a serem tomadas, gerando no operador uma atmosfera
de pressdo e nervosismo, sendo, portanto um agravante para uma possivel falha
humana.

Na interagdo com um simulador o operador pode nao se sentir imerso no ambiente
se a visualizagdo das telas nao for realista, assim uma decisao errada pode ser
percebida como sem consequéncias tdo graves quanto em um ambiente real. Portanto
0s tempos envolvidos na interagao podem tornar o operador mais suscetivel a erros.
Uma sugestao para aumentar o realismo da interagao seria a atribui¢&o de um tempo
maximo para a resolucdo de cada tarefa, visualizado pelo operador através de um
contador regressivo.
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